
 

Release Notes 

D9010CPHC 

MIPI C-PHY Conformance 

Test Application 

Keysight D9010CPHC Software Version 1.40.1 

Released Date: 25 AUG 2020 

Requirements category (e.g., operating system): Microsoft Windows 7, Microsoft Windows 10 

Requirements category (e.g., instrument software version): 06.55.00504 (90000 Series, 90000 X-Series, 90000 Q-

Series, V-Series, Z-Series) 

10.25.00902 (UXR-Series) 

11.05.00514 (MXR-Series) 

File Name: SetupInfMIPI_C-PHY01400001.exe 

Bug Fixes 

- Fixed the intermittent “Error 41” issue observed on “Eye Diagram test.  

Enhancements 

- Enhanced the final compliance result reporting for VOD, VOHHS tests when unable to 

perform the measurement.  

Known issues 

- In loading projects created in C-PHY version 1.40, users cannot append the existing 

results. 

- When user selected “HS Symbol Rate” value without clicking “Enter” on keyboard, it may 

happen rarely that the value only changed on GUI, but not actually applied. 

- When user trying to replace the test result on next trial run, error message as below may 

happen intermittently. User may click “OK” on the error message to proceed. 
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Keysight D9010CPHC Software Version 01.40 

Released Date: 14 MAY 2020 

Requirements category (e.g., operating system): Microsoft Windows 7, Microsoft Windows 10 

Requirements category (e.g., instrument software version): 06.55.00504 (90000 Series, 90000 X-Series, 90000 Q-

Series, V-Series, Z-Series) 

10.20.00503 (UXR-Series) 

11.05.00514 (MXR-Series) 

File Name: SetupInfMIPI_C-PHY01400000.exe 

Miscellaneous Notes 

– CTS v2.0 feature will only be available with “D9010CPHC” license installed. 

– Test 1.2.21 HS-TX Eye Diagram (VAB)[CTLE][above 3.5Gsps](C) and Test 1.2.22 HS-TX UI 

Jitter Peak [CTLE][above 3.5Gsps] (C) will have shorter test time on new scope models(S-

Series, V-Series, Z-Series, UXR-Series) whereas longer test time will be taken on other 

scope models(90000 Series, 90000 X-Series, 90000 Q-Series).  

New Features 

– Added “v2.0” option to “CTS” configurable option in Setup tab to support CTS v2.0 test 

items.  

- Added “HS Mode” configurable option (with remote name of “HSMode”) in Setup tab. This 

option is used to specify the HS mode. 

- Added “HS Single Ended Threshold - LVHS” configurable option (with remote name of 

“HSSingleEndedThresholdLVHS”) in Configure tab. This option is used to specify the 

threshold level for single-ended HS signal in LVHS mode. 

 

- Added the following new test IDs to support Test 1.2.7 VOD Weak0, Test 1.2.7 VOD 

Weak1, Test 1.2.10 Vcptx and Test 1.2.11 Vcptx Mismatch tests in LVHS Mode.  

o Test ID: 1708 - 1.2.7 HS-TX Differential Voltages (VOD-AB-Weak1)(LVHS) [Mean] 

o Test ID: 1709 - 1.2.7 HS-TX Differential Voltages (VOD-AB-Weak0)(LVHS) [Mean] 

o Test ID: 1718 - 1.2.7 HS-TX Differential Voltages (VOD-BC-Weak1)(LVHS) [Mean] 

o Test ID: 1719 - 1.2.7 HS-TX Differential Voltages (VOD-BC-Weak0)(LVHS) [Mean] 

o Test ID: 1728 - 1.2.7 HS-TX Differential Voltages (VOD-CA-Weak1)(LVHS) [Mean] 

o Test ID: 1729 - 1.2.7 HS-TX Differential Voltages (VOD-CA-Weak0)(LVHS) [Mean] 
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o Test ID: 1744 - 1.2.7 HS-TX Differential Voltages (VOD-AB-Weak1)(LVHS) [Mean] 

(C) 

o Test ID: 1745 - 1.2.7 HS-TX Differential Voltages (VOD-AB-Weak0)(LVHS) [Mean] 

(C) 

o Test ID: 1754 - 1.2.7 HS-TX Differential Voltages (VOD-BC-Weak1)(LVHS) [Mean] 

(C) 

o Test ID: 1755 – 1.2.7 HS-TX Differential Voltages (VOD-BC-Weak0)(LVHS) [Mean] 

(C) 

o Test ID: 1764 - 1.2.7 HS-TX Differential Voltages (VOD-CA-Weak1)(LVHS) [Mean] 

(C) 

o Test ID: 1765 - 1.2.7 HS-TX Differential Voltages (VOD-CA-Weak0)(LVHS) [Mean] 

(C) 

o Test ID: 2020 – 1.2.10 HS-TX Static Common-Point Voltages 

(VCPTX_HS_+X)(LVHS) 

o Test ID: 2021 – 1.2.10 HS-TX Static Common-Point Voltages (VCPTX_HS_-

X)(LVHS) 

o Test ID: 2022 – 1.2.10 HS-TX Static Common-Point Voltages 

(VCPTX_HS_+Y)(LVHS) 

o Test ID: 2023 – 1.2.10 HS-TX Static Common-Point Voltages (VCPTX_HS_-

Y)(LVHS) 

o Test ID: 2024 – 1.2.10 HS-TX Static Common-Point Voltages 

(VCPTX_HS_+Z)(LVHS) 

o Test ID: 2025 – 1.2.10 HS-TX Static Common-Point Voltages (VCPTX_HS_-

Z)(LVHS) 

o Test ID: 2030 – 1.2.10 HS-TX Static Common-Point Voltages 

(VCPTX_HS_+X)(LVHS) (C) 

o Test ID: 2031 – 1.2.10 HS-TX Static Common-Point Voltages (VCPTX_HS_-

X)(LVHS) (C) 

o Test ID: 2032 – 1.2.10 HS-TX Static Common-Point Voltages 

(VCPTX_HS_+Y)(LVHS) (C) 

o Test ID: 2033 – 1.2.10 HS-TX Static Common-Point Voltages (VCPTX_HS_-

Y)(LVHS) (C) 
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o Test ID: 2034 – 1.2.10 HS-TX Static Common-Point Voltages 

(VCPTX_HS_+Z)(LVHS) (C) 

o Test ID: 2035 – 1.2.10 HS-TX Static Common-Point Voltages (VCPTX_HS_-

Z)(LVHS) (C) 

o Test ID: 2120 – 1.2.11 HS-TX Static Common-Point Voltage Mismatch (Δ

VCPTX(HS))(LVHS) 

o Test ID: 2130 – 1.2.11 HS-TX Static Common-Point Voltage Mismatch (Δ

VCPTX(HS))(LVHS) (C). 

- CTS v2.0 does not support Test 1.2.20 Delta UI. App provides support by adding the 

following new informative test IDs with the “obsolete” tag in CTS v2.0. 

o Test ID: 3002 - 1.2.20 HS Delta UI (ΔUI) [1Gsps and below] (obsolete) 

o Test ID: 3003 - 1.2.20 HS Delta UI (ΔUI) [above 1Gsps] (obsolete) 

o Test ID: 3012 - 1.2.20 HS Delta UI (ΔUI) [1Gsps and below](C) (obsolete) 

o Test ID: 3013 - 1.2.20 HS Delta UI (ΔUI) [above 1Gsps](C) (obsolete) 

- Added the following new test IDs to support Test 1.2.21 Eye Diagram for Symbol Rate 

above 3.5Gsps. Available for Symbol Rate > 3.5Gsps only. These tests require InfiniiSim 

and Equalization licenses. 

o Test ID: 3104 - 1.2.21 HS-TX Eye Diagram (VAB)[CTLE][above 3.5Gsps](C)  

o Test ID: 3105 - 1.2.21 HS-TX Eye Diagram (VBC)[CTLE][above 3.5Gsps](C) 

o Test ID: 3106 - 1.2.21 HS-TX Eye Diagram (VCA)[CTLE][above 3.5Gsps](C) 

o Test ID: 3107 - 1.2.21 HS-TX Eye Diagram (VABC)[CTLE][above 3.5Gsps](C) 

- Added the following new test ID to support Test 1.2.22 UI Jitter Peak for Symbol Rate 

2.5Gsps to 3.5Gsps. Available for Symbol Rate 2.5Gsps - 3.5Gsps only. This test requires 

InfiniiSim license. 

o Test ID: 3201 - 1.2.22 HS-TX UI Jitter Peak [2.5Gsps - 3.5Gsps] (C)  

- Added the following new test ID to support Test 1.2.22 UI Jitter Peak for Symbol Rate 

above 3.5Gsps. Available for Symbol Rate > 3.5Gsps only. This test requires InfiniiSim and 

Equalization licenses. 

o Test ID: 3202 - 1.2.22 HS-TX UI Jitter Peak [CTLE][above 3.5Gsps] (C) 
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- Added “Transfer Function Setting[with CTLE]” configurable option (with remote name of 

“TxEyeRefChanTFFileSettingCTSv20”) in Configure tab. This option is used to set the 

transfer function file that the application will be embedded when performing Test 1.2.1 

HS-TX Eye Diagram and Test 1.2.22 HS-TX UI Jitter Peak tests for CTS v2.0 on symbol 

rate > 3.5Gsps. 

- Addded "CTLE Setting File" configurable option (with remote name of "CTLESettingFile") in 

configure tab. 

- Added "CTLE Optimization Criterion" configurable option (with remote name of 

"CTLEOptimizationCriterion") in configure tab. 

- Added "InfiniiSim Method" configurable option (with remote name of "InfiniiSimMethod") in 

configure tab. 

- Added "Eye Height [Eye Window Start]" configurable option (with remote name of 

"EyeHeightWindowStart") in configure tab. 

- Added "Eye Height [Eye Window Stop]" configurable option (with remote name of 

"EyeHeightWindowStop") in configure tab. 

- Added "CTLE Iteration Eye Source" configurable option (with remote name of 

"CTLEIterationEyeSource") in configure tab. 

- Added “CDR Positive Pulse Width(UI)” configurable option (with remote name of 

“PosPulseRatio”) in Configure tab under “Debug” Mode. This option is used to specify the 

positive pulse width of CDR in terms of HS UI width. 

- Added “CDR Jitter position” configurable option (with remote name of “JitterPosition”) in 

Configure tab under “Debug” Mode. This option is used to specify the CDR Jitter position. 

- Added configurable "LP Mode" configurable option (with remote name of "LPMode") in 

configure tab. This feature is only applicable for Test 1.1.1 LP-TX Thevenin Output High 

Level Voltage (VOH) ESCAPEMODE and Test 1.1.1 LP-TX Thevenin Output High Level 

Voltage (VOH) where the maximum test limit for these tests are depending on the user 

selection on this "LP Mode" configurable option. 

Enhancements 

- Updated options of “Scope Sampling Rate” in configure tab.  

- Updated Test 1.2.7 VOD Weak0, Test 1.2.7 VOD Weak1 as informative tests for CTS v2.0 

selection. 
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- Renamed "Reference Channel Transfer Function File Setting" configurable option in 

Configure tab to "Transfer Function Setting[without CTLE]". 

Bug Fixes 

- Fixed test limit for Test 1.2.3 T3-PREBEGIN Duration.  

Known issues 

- In loading projects created in C-PHY version 1.33, users cannot append the existing 

results. 

- When user selected “HS Symbol Rate” value without clicking “Enter” on keyboard, it may 

happen rarely that the value only changed on GUI, but not actually applied. 
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Keysight D9010CPHC Software Version 01.33 

Released Date: 31 MAY 2019 

Requirements category (e.g., operating system): Microsoft Windows 7, Microsoft Windows 10 

Requirements category (e.g., instrument software version): 06.40.00714 (90000 Series, 90000 X-Series, 90000 Q-

Series, V-Series, Z-Series, 

10.10.04513 (UXR-Series) 

File Name: SetupInfMIPI_C-PHY01330000.exe 

Miscellaneous Notes 

– Updated the product number from “U7250A” to “D9010CPHC” to support PPKS licenses. 

New Features 

- NA 

Enhancements 

- Updated option name of “OFF” to “Custom Channel” for “Reference Channel Transfer 

Function File Setting” (with remote name of “TxEyeRefChanTFFileSetting”) configurable 

option in Configure tab. 

- Updated the default value of “Mask” (with remote name of “TxMaskBERType”) configurable 

option in Configure tab from “Original(1E-12)” to “Prorated(1E-6)”.  

- Updated prorated mask value (1E-6) for 1.2.21 HS-TX Eye Diagram tests.  

Bug Fixes 

- Fixed eye diagram test where the voltage level of the trigger point might locate slightly 

above 0V. 

Known issues 

- In loading projects created in C-PHY version 1.32, users cannot append the existing 

results. 

- Screenshot timeout issue can happen rarely when running tests. 

- No message will be prompted when user selected “Tools-> Infiniium -> InfiniiSim…” or 

“Tools-> Infiniium -> PrecisionProbe/PrecisionCable…” feature without installing the 

required license.  
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Keysight U7250A Software Version 01.32 

Released Date: 13 DEC 2018 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., instrument software version): 06.30.00701 (90000 Series, 90000 X-Series, 90000 Q-

Series, V-Series, Z-Series, 

10.00.03902 (UXR-Series) 

File Name: SetupInfMIPI_C-PHY01320000.exe 

New Features 

- NA 

Enhancements 

- Updated algorithm of burst mode VOD and VOHHS tests. 

- Added “Acquisition Points[HS Tests] - Burst Mode VOD, VOHHS” configurable option (with 

remote name of “HSTestVODVOHHSAcqPoints”) in Configure tab. This option is used to 

specify the acquisition points Burst signal for VOD and VOHHS tests. 

- Removed “Interpolation Factor[VOD,VOHHS]” configurable option (with remote name of 

“InterpolationFactor_VOD_VOHHS”) in Configure tab. 

Bug Fixes 

- NA 

 

Known issues 

- In loading projects created in C-PHY version 1.31, users cannot append the existing 

results. 

- Screenshot timeout issue can happen rarely when running tests. 

- For eye diagram test, the voltage level of the trigger point might locate slightly above 0V.  
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Keysight U7250A Software Version 01.31 

Released Date: 27 SEPT 2018 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., instrument software version): 06.30.00517 (90000 Series, 90000 X-Series, 90000 Q-

Series, V-Series, Z-Series, 

10.00.03708 (UXR-Series) 

File Name: SetupInfMIPI_C-PHY01310000.exe 

New Features 

- Supports Infiniium Oscilloscope Software version 10.00 for UXR-Series oscilloscope. 

o Added new options (8GSa/s, 16GSa/s, 32GSa/s, 64GSa/s) for “Scope Sampling 

Rate (with remote name of “ScopeSampleRate”) configurable option in Configure 

tab. These options will be available when launching application on UXR-Series 

Oscilloscope. The default value is 32GSa/s for UXR-Series Oscilloscope. 

Enhancements 

- Updated the VOD mismatch equation on Test 1.2.8 HS-TX Differential Voltage 

Mismatch(ΔVOD).  

- Updated Test 1.2.16 T3-POST position finding algorithm to cater for noise at end of the 

burst.  

o Added “HS Differential Threshold[T3-POST]” configurable option (with remote 

name of “HSDifferentialThreshold_T3POST”) in Configure tab. This option is used to 

determine the end point of T3-POST and only applicable for Test 1.2.16 T3-POST 

Duration. 

o Updated the configurable option name from “HS Differential Threshold[T3-POST, 

THS-EXIT]” to “HS Differential Threshold[THS-EXIT]”. This option is used to 

determine the start point of THS-EXIT and only applicable for Test 1.2.18 THS-EXIT 

Value. 

- Updated Test 1.2.7 VOD to enable the histogram window position value to be configurable. 

o Added “VOD Histogram Window Position(UI)” configurable option (with remote 

name of “VODHistogramWindowPosition”) in Configure tab. This option is used to 

specify the histogram window position for VOD measurement. 

- Updated Test 1.2.9 VOHHS to enable the histogram window position value to be  

configurable. 

o Added “VOHHS Histogram Window Position(UI)” configurable option (with remote 

name of “VOHHSHistogramWindowPosition”) in Configure tab. This option is used 

to specify the histogram window position for VOHHS measurement. 
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Bug Fixes 

- Fixed intermittently incomplete test issue on Test HS-TX Differential Voltage(VOD-

ABC)(Informative Test)(C).  

- Fixed issue on Test 1.2.2 T3-PREPARE when finding end of T3-PREPARE position.  

o Added “HS Differential Hysteresis[T3-PREPARE]” configurable option (with remote 

name of “HSDifferentialHysteresis_T3PREPARE”) in Configure tab. This option is 

used to determine the hysteresis level when finding the end point of T3_PREPARE 

Duration.  

Known issues 

- In loading projects created in C-PHY version 1.30, users cannot append the existing 

results. 

- Screenshot timeout issue can happen rarely when running tests in UXR-Series 

oscilloscope. 
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Keysight U7250A Software Version 01.30 

Released Date: 22 FEB 2018 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., instrument software version): 06.10.00806 (90000 Series, 90000 X-Series, 90000 Q-

Series, V-Series, Z-Series), 

File Name: SetupInfMIPI_C-PHY01300000.exe 

New Features 

- Added Test 1.2.3 T3-PREBEGIN Duration, Test 1.2.4 T3-PROGSEQ Duration, Test 1.2.5 T3-

PREEND Duration, Test 1.2.6 T3-SYNC Duration and Test 1.2.16 T3-POST Duration tests. 

o Test ID: 1300 - 1.2.3 T3-PREBEGIN Duration 

o Test ID: 1400 - 1.2.4 T3-PROGSEQ Duration 

o Test ID: 1500 - 1.2.5 T3-PREEND Duration 

o Test ID: 1600 - 1.2.6 T3-SYNC Duration 

o Test ID: 2600 - 1.2.16 T3-POST Duration 

- Added “T3-PROGSEQMode” configurable option (with remote name of “pcbT3_ProgSeq”) 

in Set Up tab. This option allows user to select T3-PROGSEQ mode. 

- Added “T3-PROGSEQ Sequence” configurable option (with remote name of 

“T3PROGSEQSequence”) in Set Up tab. This option allows user to specify the                  

T3-PROGSEQ symbol Sequence. 

- Added support for N7010A Active Termination Adapter. This feature will be enabled when 

user connected N7010A Active Termination Adapter to the VA, VB and VC channels on the 

scope based on the selection of “Channel Selection” Configurable option in the Connection 

Setup form.  

o Added “Direct Connect (Active Termination Adapter)” Probing Method option in 

Connection Setup form in Set Up tab. This probing method supports for continuous 

signal. 

o Added “Check Probe” feature to check if the N7010A Active Termination Adapter 

has been connected to the VA, VB and VC channels on the scope based on the 

selection of “Channel Selection” Configurable option. The available probing method 

will be shown.  

- Added N7010A Active Termination Adapter Calibration feature. The continuous HS signal 

is required for N7010A calibration.  
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o Added “RSE Method” selection(with remote name of “RSEValueMethod”) in 

Connection Setup form with the options of “Manual RSE” and “Calculated RSE”. 

This option allows user to specify the RSE value manually or auto calculated by 

application for N7010A Calibration. 

o Added “RSE Value” configurable option (with remote name of “RSEValue”) in 

Connection Setup form which is only available if user selected “Manual RSE” for 

“RSE Method” selection. This option allows user to specify the RSE value manually. 

o Added “N7010A Calibration” option which enable user to find the appropriate 

Vterm value. The calculated “Vterm” value will be displayed and applied for all tests 

after performing the N7010A Calibration. 

- Added the following new tests to support Continuous signal. These tests will be enabled if 

user selected “v1.1” for “CTS” configurable option and “Direct Connect (Active Termination 

Adapter” for “Probing Method” configurable option.  

o Test ID: 1910 - 1.2.9 HS-TX Single-Ended Output High Voltages (VOHHS(VA))(C) 

o Test ID: 1911 - 1.2.9 HS-TX Single-Ended Output High Voltages (VOHHS(VB))(C) 

o Test ID: 1912 - 1.2.9 HS-TX Single-Ended Output High Voltages (VOHHS(VC))(C) 

o Test ID: 2010 - 1.2.10 HS-TX Static Common-Point Voltages (VCPTX_HS_+X)(C) 

o Test ID: 2011 - 1.2.10 HS-TX Static Common-Point Voltages (VCPTX_HS_-X)(C) 

o Test ID: 2012 - 1.2.10 HS-TX Static Common-Point Voltages (VCPTX_HS_+Y)(C) 

o Test ID: 2013 - 1.2.10 HS-TX Static Common-Point Voltages (VCPTX_HS_-Y)(C) 

o Test ID: 2014 - 1.2.10 HS-TX Static Common-Point Voltages (VCPTX_HS_+Z)(C) 

o Test ID: 2015 - 1.2.10 HS-TX Static Common-Point Voltages (VCPTX_HS_-Z)(C) 

o Test ID: 2110 - 1.2.11 HS-TX Static Common-Point Voltage Mismatch                     

(ΔVCPTX(HS))(C) 

o Test ID: 2210 - 1.2.12 HS-TX Dynamic Common-Point Variations Between           

50-450MHz (ΔVCPTX(LF))(C) 

o Test ID: 2310 - 1.2.13 HS-TX Dynamic Common-Point Variations Above 450MHz       

(ΔVCPTX(HF))(C) 

- Updated Test 1.2.7 HS-TX Differential Voltages (VOD) tests to measure MEAN VOD. 

Added the following Test IDs to support VOD-Mean measurement for CTS v1.1 option. 
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o Test ID: 1704 - 1.2.7 HS-TX Differential Voltages (VOD-AB-Strong1) [Mean] 

o Test ID: 1705 - 1.2.7 HS-TX Differential Voltages (VOD-AB-Weak1) [Mean] 

o Test ID: 1706 - 1.2.7 HS-TX Differential Voltages (VOD-AB-Weak0) [Mean] 

o Test ID: 1707 - 1.2.7 HS-TX Differential Voltages (VOD-AB-Strong0) [Mean] 

o Test ID: 1714 - 1.2.7 HS-TX Differential Voltages (VOD-BC-Strong1) [Mean] 

o Test ID: 1715 - 1.2.7 HS-TX Differential Voltages (VOD-BC-Weak1) [Mean] 

o Test ID: 1716 - 1.2.7 HS-TX Differential Voltages (VOD-BC-Weak0) [Mean] 

o Test ID: 1717 - 1.2.7 HS-TX Differential Voltages (VOD-BC-Strong0) [Mean] 

o Test ID: 1724 - 1.2.7 HS-TX Differential Voltages (VOD-CA-Strong1) [Mean] 

o Test ID: 1725 - 1.2.7 HS-TX Differential Voltages (VOD-CA-Weak1) [Mean] 

o Test ID: 1726 - 1.2.7 HS-TX Differential Voltages (VOD-CA-Weak0) [Mean] 

o Test ID: 1727 - 1.2.7 HS-TX Differential Voltages (VOD-CA-Strong0) [Mean] 

o Test ID: 1801 - 1.2.8 HS-TX Differential Voltage Mismatch (ΔVOD) 

Updated test name for Test 1.2.7 HS-TX Differential Voltages (VOD) (C). [Test IDs: 1740, 

1741, 1742, 1743, 1750, 1751, 1752, 1753, 1760, 1761, 1762, 1763]. Updated the VOD 

tests to measure MEAN VOD. 

- Added “VOD Histogram Window Mode” configurable option(with remote name of 

“VODHistogramWindowMode”) in Configure tab. This option allows user to specify the 

method to be used to determine the histogram window position for Test 1.2.7 VOD test. 

- Added “VOD Histogram Window Height(V)[AUTO Mode]” configurable option(with remote 

name of “VODHistogramWindowHeightAutoMode”) in Configure tab. This option allows 

user to specify the histogram height which is used to determine the histogram window 

position for Test 1.2.7 VOD test. 

- Added “VOD(Strong1, Weak1) Histogram Window(V)[Manual Mode]” configurable 

option(with remote name of “VODTestStrong1Weak1HistogramWindowManualMode”) in 

Configure tab. This option allows user to specify the bottom limit of the histogram window 

for VOD-Strong1 and top limit of the histogram window for VOD-Weak1 measurement. 

- Added “VOD(Strong0, Weak0) Histogram Window(V)[Manual Mode]” configurable 

option(with remote name of “VODTestWeak0Strong0HistogramWindowManualMode”) in 
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Configure tab. This option allows user to specify the bottom limit of the histogram window 

for VOD-Weak0 and top limit of the histogram window for VOD-Strong0 measurement. 

- Added support for new export to repository feature where user can export test results to a 

repository (such as a database). [File->Export Results…->Repository] 

Enhancements 

- Migrated application to use new graphics user interface environment. 

- Updated the configurable option name from “HS Differential Threshold[THS-EXIT]” to “HS 

Differential Threshold[T3-POST, THS-EXIT]”. 

- Updated HS Symbol Rate verification. 

Bug Fixes 

- Fixed issue on Test 1.2.7 VOD tests where the LP state is included in the real time eye.  

Known issues 

- Does NOT support backward compatibility. Project files saved in previous versions will be 

available as READ-ONLY. User have to save previous project files as Settings Only before 

loading the project in the current software to access all the supported configurations. 

[File->Save Project (Settings Only) As...] 
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Keysight U7250A Software Version 01.21 

Released Date: 15 SEPT 2017 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., instrument software version): 06.10.00524 (90000 Series, 90000 X-Series, 90000 Q-

Series, V-Series, Z-Series), 

File Name: SetupInfMIPI_C-PHY01210000.exe 

New Features 

- Added “LP-000 To LP-111 Transition Effect Duration(s)” configurable option (with remote 

name of “LP000ToLP111TransitionEffectDuration”) in Configure tab. This option is used to 

avoid glitch problem for TREOT and THS-EXIT measurement. 

- Added “CdrCPHY Hysteresis Threshold(V)” configurable option (with remote name of 

“CdrCPHY_HysThresh”) in Configure tab. This option is used to specify the hysteresis value 

when finding edges' position on single-ended signal and differential signal using CdrCPHY 

User-Defined Function for burst signal. 

- Added “Minimum Valid HS Length[Global Timing Tests]” configurable option (with remote 

name of “MinValidHSLengthT3TimingTest”) in Configure tab. This option is used to specify 

the minimum valid HS length during triggering for Global Timing tests except THS-EXIT 

and TREOT tests. 

Enhancements 

- Updated burst finding algorithm to support signal integrity issue on LP-001 state.  

- Updated test procedure of Test 1.2.2 T3-PREPARE Duration.  

- Updated default value of “HS Differential Threshold[T3-PREPARE, TREOT]” and “HS 

Differential Threshold[THS-EXIT]” configurable option.  

Bug Fixes 

- Fixed issue on channel InfiniiSim for Test 1.2.21 HS-TX Eye Diagram. 

- Corrected the ΔVCPTX(HS) calculation on Test 1.2.11 HS-TX Static Common-Point 

Voltage Mismatch. 

Known issues 

- In loading projects created in C-PHY version 1.20, users cannot append the existing 

results. 
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Keysight U7250A Software Version 01.20 

Released Date: 1 JUNE 2017 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., instrument software version): 06.00.00628 (90000 Series, 90000 X-Series, 90000 Q-

Series, V-Series, Z-Series), 

File Name: SetupInfMIPI_C-PHY01200000.exe 

New Features 

- Added “CTS” configurable option (with remote name of “CTSVersion”) in Set Up tab with 

the options of “v1.0” and “v1.1”. This option allows user to specify the CTS version to 

reflect the available test list accordingly.  

- Added “MIPI C-PHY Test Limit v1.1” compliance limit set. This compliance limit set will be 

activated if user selected “v1.1” for configurable option of “CTS”.  

- Added Connection Setup form in Set Up tab which allows user to specify the channel and 

probing method selection. 

Added “Probing Method” configurable option (with remote name of “ProbingMethod”) in 

Connection Setup form with the options of “Active Probe (Differential Probe)” and “Direct 

Connect”.  

The option of “Active Probe (Differential Probe)” is available for both CTS “v1.0” and “v1.1” 

selection. This probing method supports for burst signal. 

The option of “Direct Connect” probing method is only available for CTS “v1.1” selection. 

This probing method supports for continuous signal. 

- Added the following new tests to support Continuous signal. These tests will be enabled if 

user selected “v1.1” for “CTS” configurable option and “Direct Connect” for “Probing 

Method” configurable option.  

Test ID: 1740 - 1.2.7 HS-TX Differential Voltages (VOD-AB-Strong1) [Max](C) 

Test ID: 1741 - 1.2.7 HS-TX Differential Voltages (VOD-AB-Weak1) [Min](C) 

Test ID: 1742 - 1.2.7 HS-TX Differential Voltages (VOD-AB-Weak0) [Max](C) 

Test ID: 1743 - 1.2.7 HS-TX Differential Voltages (VOD-AB-Strong0) [Min](C) 

Test ID: 1750 - 1.2.7 HS-TX Differential Voltages (VOD-BC-Strong1) [Max](C) 

Test ID: 1751 - 1.2.7 HS-TX Differential Voltages (VOD-BC-Weak1) [Min](C) 

Test ID: 1752 - 1.2.7 HS-TX Differential Voltages (VOD-BC-Weak0) [Max](C) 
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Test ID: 1753 - 1.2.7 HS-TX Differential Voltages (VOD-BC-Strong0) [Min](C) 

Test ID: 1760 - 1.2.7 HS-TX Differential Voltages (VOD-CA-Strong1) [Max](C) 

Test ID: 1761 - 1.2.7 HS-TX Differential Voltages (VOD-CA-Weak1) [Min](C) 

Test ID: 1762 - 1.2.7 HS-TX Differential Voltages (VOD-CA-Weak0) [Max](C) 

Test ID: 1763 - 1.2.7 HS-TX Differential Voltages (VOD-CA-Strong0) [Min](C) 

Test ID: 1810 - 1.2.8 HS-TX Differential Voltage Mismatch (ΔVOD)(C) 

Test ID: 2910 - 1.2.19 HS Instantaneous UI (UIINST_Max)(C) 

Test ID: 3010 - 1.2.20 HS Delta UI (ΔUI) [1Gsps and below](C) 

Test ID: 3011 - 1.2.20 HS Delta UI (ΔUI) [above 1Gsps](C) 

Test ID: 1770 - HS-TX Differential Voltages (VOD-ABC)(Informative)(C) 

- Added the following configurable options in Configure tab to support Continuous signal. 

Label Variable 

Acquisition Points[HS Tests] - Continuous 

Mode 

HSTestContinuousAcqPoints 

- Added the following new eye diagram tests under “HS Electrical Tests” test group. These 

tests will be enabled if user selected “v1.1” for configurable option of “CTS” and “Direct 

Connect” for configurable option of “Probing Method”. These tests support for continuous 

signal only. 

Test ID: 3100 - 1.2.21 HS-TX Eye Diagram (VAB)(C) 

Test ID: 3101 - 1.2.21 HS-TX Eye Diagram (VBC)(C) 

Test ID: 3102 - 1.2.21 HS-TX Eye Diagram (VCA)(C) 

Test ID: 3103 - 1.2.21 HS-TX Eye Diagram (VABC)(C) 

The license of (N5465A-001) InfiniiSim Basic or (N5465A-002) InfiniiSim Advanced will be 

required to enable Test 1.2.1 HS-TX Eye Diagram. 

- Added “Eye Diagram Type” configurable option (with remote name of 

“TxEyeDiagramType”) in Set Up tab with the options of “Combined eye diagram” and 

“Separated 3 eye diagram”. This option is used to specify the eye diagram type between 

“Combined eye diagram” and “Separated 3 eye diagram” which reflects the available eye 

diagram tests in test list accordingly. 
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If user selected “Separated 3 eye diagram”, the following tests will be enabled.  

Test ID: 3100 - 1.2.21 HS-TX Eye Diagram (VAB) 

Test ID: 3101 - 1.2.21 HS-TX Eye Diagram (VBC) 

Test ID: 3102 - 1.2.21 HS-TX Eye Diagram (VCA) 

If user selected “Combined eye diagram”, the following test will be enabled. 

Test ID: 3103 - 1.2.21 HS-TX Eye Diagram (VABC) 

- Added the following configurable options in Configure tab for Test 1.2.21 HS-TX Eye 

Diagram tests.  

Label Variable 

Single Acquisition Points TxEyeSingleAcqPoints 

Total Acquisition Length [UI] TxEyeTotalAcqUILength 

Reference Channel Transfer Function File 

Setting 

TxEyeRefChanTFFileSetting 

Mask Type TxEyeMaskType 

Mask TxMaskBERType 

Mask File Path TxEyeMaskFilePath 

Initial Mask Position for Trigger Points(UI) InitialMaskPosition 

Moving Mask Unit(UI) MovingMaskUnit 

Mask Shifting - Number of UI MaskShiftingNoOfUI 

 

Enhancements 

- Updated the default value of “Eye Diagram Display - Horizontal Center Position(UI)” 

configurable option (with remote name of “EyeDiagramCenterPos_VOD_VOHHS”) in 

Configure tab from “0UI” to “0.5UI”. 

- Updated connection diagram for all tests. 

- Renamed test group’s name from “HS Timing Tests” to “Global Timing Tests”.  
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- Moved the following test from “HS Electrical Tests” test group to “Global Timing Tests” test 

group. 

Test ID: 2700 - 1.2.17 30%-85% Post-EoT Rise Time (TREOT) 

- Renamed the following tests: 

Test ID: 2900 - 1.2.19 HS Instantaneous UI (UIINST_Max)  

[Old Name: 1.2.19 HS Clock Instantaneous UI (UIINST_Max)] 

Test ID: 3000 - 1.2.20 HS Delta UI (ΔUI) [1Gsps and below] 

[Old Name: 1.2.20 HS Clock Delta UI (ΔUI) [1Gsps and below] 

Test ID: 3001 - 1.2.20 HS Delta UI (ΔUI) [above 1Gsps] 

[Old Name: 1.2.20 HS Clock Delta UI (ΔUI) [above 1Gsps] 

- Renamed the following tests to indicate that these tests are informative tests.  

Test ID: 101 - 1.1.1 LP-TX Thevenin Output High Level Voltage (VOH)(Informative) 

[Old Name: 1.1.1 LP-TX Thevenin Output High Level Voltage (VOH)] 

Test ID: 201 - 1.1.2 LP-TX Thevenin Output Low Level Voltage (VOL)(Informative) 

[Old Name: 1.1.2 LP-TX Thevenin Output Low Level Voltage (VOL)] 

Test ID: 401 - 1.1.4 LP-TX 15%-85% Fall Time (TFLP)(Informative) 

[Old Name: 1.1.4 LP-TX 15%-85% Fall Time (TFLP)] 

- Moved the following configurable options from Configure tab to Connection Setup form in 

Set Up tab.  

Label  Variable 

VA VAChan 

VB VBChan 

VC VCChan 

- Updated “CombinedCPHYWaveform” user defined function.  

- Updated the “HS Symbol Rate” configurable option in Set Up tab to display warning 

message if value entered is less than the minimum value of 80Msps.  
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Bug Fixes 

- Corrected the test limit for Test ID: 401 - 1.1.4 LP-TX 15%-85% Fall Time (TFLP). 

Known issues 

- In loading projects created in C-PHY version 1.12, users cannot append the existing 

results. 
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Keysight U7250A Software Version 01.12 

Released Date: 28 MARCH 2017 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., instrument software version): 06.00.00602 (90000 Series, 90000 X-Series, 90000 Q-

Series, V-Series, Z-Series), 

File Name: SetupInfMIPI_C-PHY01120000.exe 

New Features 

- Added "VA(TrioA) edges(Edge)" configurable option (with remote name of 

“NumVAEdgesToExclude”) in Configure tab. This option is used to specify the number of 

VA(TrioA) HS edges to be excluded when performing HS data measurement. 

- Added the following informative test under “Informative Tests” test group.  

Test ID: 1730 - HS-TX Differential Voltages (VOD-ABC) (Informative) 

- Enabled "Disable Infiniium user interface during run" feature. 

- Added “LP Data Rate” configurable option (with remote name of “LPDataRate”) in 

Configure tab. This option is used to calculate the zone’s horizontal length for zone 

triggering when running LP Escape Mode tests. This option is only applicable for all LP 

Escape Mode tests. 

Known issues 

- In loading projects created in C-PHY version 1.10, users cannot append the existing 

results. 
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Keysight U7250A Software Version 01.10 

Released Date: 29 SEPTEMBER 2016 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., instrument software version): 5.70.00713 (90000 Series, 90000 X-Series, 90000 Q-

Series, Z-Series), 

File Name: SetupInfMIPI_C-PHY01100000.exe 

New Features 

- Added “HSBurstStart Check” configurable option (with remote name of 

“CdrCPHY_HSBurstStart_Check”) in Configure tab. This option is used to perform 

additional checking using VC LP falling edge when searching the starting location of HS 

burst data.  

Added “VC LP Falling Edge Threshold” configurable option (with remote name of 

“CdrCPHY_VCLPFallingEdgeThreshold”) in Configure tab. This option is used to specify the 

threshold value used to locate the position of VC LP falling edge next to VA LP falling edge 

at LP001 region. This option is only applicable if “HSBurstStart Check” configurable option 

is enabled. 

Enhancements 

- Updated the hysteresis range used for finding edges in CdrCPHY User Defined Function. 

Bug Fixes 

- Fixed the issue found in Test 1.2.10 – HS-TX Static Common-Point Voltages. 

Known issues 

- In loading projects created in C-PHY version 1.00, users cannot append the existing 

results. 
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Keysight U7250A Software Version 01.00 

Released Date: 5 MAY 2016 

Requirements category (e.g., operating system): Microsoft Windows 7 

Requirements category (e.g., instrument software version): 5.60 (90000 Series, 90000 X-Series, 90000 Q-Series, Z-

Series), 

File Name: SetupInfMIPI_C-PHY01000000.exe 

Initial Release 

Miscellaneous Notes 

– Initial release will consist of 3 main test groups namely HS Electrical Tests, LP Tests and 

HS Timing Tests based on MIPI CPHY CTS v1.0. 
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